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摘要 

紫外光會造成皮膚組織結構受損，臨床上常藉由分析皮膚通透性變化評估其損傷程度，

但檢測成本相當昂貴。本研究利用葉綠體能滲入受損皮膚內的特性，以伍氏燈之紫外光激發

番薯葉葉綠體螢光，研發一套安全又低成本的創新性檢測方法。此研究發現，照射陽光與紫

外光美甲燈，都會增加葉綠體穿透表皮的數量，防曬乳能減緩通透情形。人體檢測發現，皮

膚對於紫外光的傷害有迅速修復的能力。然而，長期曝曬產生的曬斑部位，通透性明顯高於

周邊皮膚，是不可回復的損傷，因此應避免累積性的紫外光傷害。研究成果顯示，我們所提

出的檢測方法能有效評估皮膚損傷程度，為臨床上開發簡易皮膚檢測方法提供嶄新概念。 

 

壹、前言 

一、研究動機 

    原本我們想研究綠色植物的汁液是否有防曬效果，所以，將表面塗抹了蔬菜汁的

豬皮，放在紫外光美甲燈下照射，再利用組員爸爸提供的皮膚檢測儀觀察表皮的紋路

變化。我們觀察到在檢測儀紫外光照射下，蔬菜汁中的葉綠體呈現一顆顆紅色光點。 

    經過清水沖洗後再觀察，發現葉綠體彷彿滲入皮膚內，即使反覆沖洗，在檢測儀

下還是看到螢光點。難道紫外光讓豬皮表面孔隙變大，讓葉綠體能通過皮膚嗎？連續

追蹤葉綠體的滲透情形，就能了解皮膚受損及修復的狀況嗎？因此，我們想透過偵測

葉綠體滲入皮膚數量的變化，研發一套安全又低成本的皮膚檢測工具。 

二、研究目的  

(一) 探討美甲燈光與太陽光對皮膚傷害的程度及其對角質層與毛孔的影響。 

(二) 分析皮膚受損的檢測方法，並研發一種操作簡便的檢測工具。 

(三) 利用綠色蔬菜萃取植物葉綠體製作檢測試劑，建立試劑製作與檢測標準化流程。 

(四) 探討各種防護方法，降低紫外光對動物皮膚產生的傷害。 

(五) 研究紫外光對人體皮膚通透性的影響，並評估其復原能力。 

 



3 
 

三、文獻探討 

(一) 紫外光對皮膚的傷害與影響 

紫外光是一種波長比可見光短的射線，由於波長比正常人能看到最短波長的紫光更

短，因此稱為紫外光。太陽光中含有的紫外光為一般人最常接觸到的紫外光。而美

甲時照射的美甲燈光也是人為產生的紫外光。紫外光除了會使皮膚變黑，對皮膚對

毛孔大小變化的影響，已成為皮膚科學研究的重要課題。紫外光可破壞皮膚結構，

導致毛孔擴大，影響肌膚健康與外觀。有報導指出，紫外光會破壞真皮層中的膠原

蛋白，使皮膚結構受損失去支撐力，毛孔周圍的組織可能塌陷，導致毛孔擴大。也

有報導提到，短時間內照射美甲燈，紫外光劑量可能相當於一天的太陽曝曬，可能

導致皮膚細胞 DNA 損傷，增加皮膚癌風險。這些報導究竟有多少科學根據?值得我

們設計實驗進行驗證。 

(二) 美甲凝膠與美甲燈 

   美甲凝膠中的丙烯酸酯、甲基丙烯酸酯兩種成分在紫外光照射下，會產生聚合反

應，再加上光引劑的作用，凝膠就會逐漸凝固。由於紫外光 (UV)光源美甲燈會使

手指皮膚曬黑，業者逐漸開發出傷害較小的 LED 燈管，但適用的美甲膠種類有限。

因此，近年又開發出結合兩種光源的混合型美甲燈，目前美甲店會依據凝膠種類決

定照射 UV 光源或混合光源美甲燈。 

(三) 葉綠素 

    大多數綠色植物的葉片中會利用葉綠體中的葉綠素進行光合作用，葉綠素依照主要

吸收光的波段又可分為葉綠素 a~d 四種。其中葉綠素 a 與 b 的吸收光譜較接近，在

紫光區（波長 430~480 奈米）和紅光區（波長 640~660 奈米）都有一個吸收的高峰 

(圖 1a)。當葉綠素 a 受到紫外光照射後，吸收能量經轉換後會釋放出紅色螢光(圖

1b)，這就是葉綠體受到紫外光照射後會變為一顆顆紅色亮點的原因。 
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圖 1. 葉綠素光譜 (a) 葉綠素吸收光譜 (b) 葉綠素螢光光譜 

(參考 47 屆科展作品自行繪製) 

(四) 皮膚檢測儀 (伍氏燈) 

伍氏燈(圖 2)為一種紫外線燈，是常見的皮膚或口腔微生物感

染的檢測工具。當皮癬菌﹑皮屑芽苞菌、痤瘡丙酸桿菌等微生

物感染皮膚時, 微生物會製造含卟ㄅ
ㄨ
ˇ啉

ㄌ
一
ㄣ  ́ (porphyrin)的代謝物，

這些物質在特定波長的光源照射下具有螢光轉換特性。在臨床

檢測上就經常以波長 354 奈米紫外光照射檢測部位，透過濾鏡

後，可以看到卟啉產生波長 600 奈米的紅色螢光，如此可以很

快的知道檢測部位是不是受到微生物感染。市面上許多皮膚檢

測儀都是利用這個原理，設計不同的皮膚檢測探頭，觀察真皮

層狀態，可以檢測皮屑皮脂，提供毛孔大小與髮徑等資訊，進行分析比對。由於利

用紫外光誘發微生物代謝物質螢光的檢測原理可能同時激發葉綠素 a 產生紅色螢

光，可提供我們檢測葉綠素含量的工具。 

(五) 豬皮部位的選擇 

過去許多研究常會以豬皮來模擬人類皮膚，進行相關實驗。而不同部位的豬皮，厚

薄與表面質地都不相同，尤其是豬皮表面的毛髮各部位數量差異很大。在查詢資料

後發現，豬耳朵皮膚的角質層厚度約為 21 微米，與人類背部皮膚的 19 微米相近。

豬耳朵皮膚每平方公分約有 20 根毛髮，人類因部位與不同人差異，平均約 14~32

圖 2. 伍氏燈 

(自行拍攝) 
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根毛髮。雖然豬耳朵皮膚毛孔直徑為人類汗毛的 2~5 倍，但相較於其他部位的皮

膚，豬耳朵與人類的差異最小，更適合進行物質經皮膚通透的實驗。 

貳、研究設備器材 

一、實驗材料 二、檢測儀器 

(一) 豬皮 (帶毛後頸至耳部皮膚)                          

(二) 蔬菜葉片(番薯葉、空心菜、紅莧菜)                                            

(三) 果汁機 

(四) 篩網 (20 目、60 目、100 目) 

(五) 相關化妝品 (凡士林、防曬乳、卸妝油) 

(六) 美甲燈 (UV 光源、混合光源) 

(七) 面膜刷 

(一) 紫外線檢測卡                        

(二) 皮膚檢測儀                                         

(三) 顯微鏡 

(四) 計數軟體 

⚫ Cell counter 

⚫ Object counter 

⚫ ImageJ 

表 1. 實驗材料與檢測儀器 

參、研究過程或方法 

    經過相關文獻的蒐集與討論後，我們訂定以下研究架構: 

 

圖 3. 研究架構圖 (自行繪製) 
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    雖然超市賣場販售的蔬菜大多都有相關安全認證，仍然擔心會有藥品殘留風險。我們決

定使用學校教材園自種的蔬菜為材料，確保原料不含化肥與藥劑。從種植蔬菜中挑選番薯葉、

空心菜，與紅莧菜三種蔬菜製作試劑，實驗流程如下: 

一、建立葉綠體試劑製作的標準化流程 

(一) 採集蔬菜葉片，利用果汁機以 150 克重菜葉搭配 100 毫升冷開水的比例，以每分鐘

3000 轉的轉速，分三次榨取菜汁，每次時間為 20 秒[圖 4(a)-(d)]。 

(二) 利用不同孔隙濾網分別濾除粗纖維、細纖維，及懸浮雜質後得到澄清液[圖 4(e)-(g)]。 

(三) 以微量滴管取 0.1 毫升澄清液滴於凹槽載玻片上，在顯微鏡下觀察並比較三種菜汁

內葉綠體的含量濃度[圖 4(h)-(j)]。 

(四) 利用皮膚檢測儀照射凹槽中的菜汁，觀察葉綠體是否產生螢光反應[圖 4(k)]。 

(五) 嘗試利用各種自動計數軟體，計算螢光點數量[圖 4(l)]。 

    

(a) 採集蔬菜 (b) 清洗菜葉 (c) 秤重 (150 克) (d) 果汁機榨汁 

 

 

   

(e) 濾除粗纖維 (f) 濾除細纖維 (g) 濾除懸浮雜質 (h) 滴於載玻片上 

 

 

  

 

(i) 顯微鏡觀察試劑 (j) 試劑中的葉綠體 (k) 測試螢光反應 (l) 試用計數軟體 

圖 4. 葉綠體試劑製作流程 (自行拍攝) 
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二、建立試劑檢測的標準化流程 

(一) 將新鮮豬皮剪為邊長 5 公分的正方形，每張豬皮可得到 7~10 塊進行實驗[圖 5(a)]。 

(二) 將同一張豬皮的組織實驗組分五組，在美甲燈下照射 240 秒[圖 5(b)]，再以面膜刷塗

抹試劑[圖 5(c)]，分別等待 1、2、3、4、5 分鐘後，洗除進行檢測，利用 ImageJ 軟體

計算各組螢光點數量[圖 5(d)]，找出試劑停留的標準時間。 

(三) 將同一張豬皮的組織分為四組，分別在豬皮上塗抹 0.2、0.4、0.6、0.8 毫升的試劑，

對照組塗抹相同體積的清水。洗淨後，以皮膚檢測儀檢測表面葉綠體殘留的情形，

找出試劑塗抹的標準劑量。 

 

  

 

 

(a) 裁剪豬皮 (b) 照射美甲燈 (c) 面膜刷塗抹試劑 (d) 計算螢光點 

圖 5. 建立檢測標準化流程 (自行拍攝) 

 

三、探討美甲燈光與太陽光對動物皮膚葉綠體通透性的影響 

(一) 參考美甲流程，將實驗組分五次照射美甲燈，每次間隔 10 分鐘。結束後以標準化流

程計算螢光點數量，對照組則放置於室內日光燈下。 

 

圖 6. 凝膠美甲行程 (自行繪製) 

 

(二) 模擬戶外體育課實際在太陽下活動的時間，將實驗組放置於晴天陽光下曝曬 20 分鐘

[圖 7(e)]。結束後以標準化流程計算螢光點數量，對照組則放置於室內日光燈下。 
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(三) 透過螢光點數量，分析照射美甲燈與太陽光後，豬皮葉綠體通透性的變化情形。 

美 

甲 

燈 

組 
 

 

 

(a) 確認通透性正常 (b)模擬美甲照燈行程 (c) 燈照後通透性變化 

陽 

光 

組 

   

(d) 確認通透性正常 (e) 陽光下曝曬 20 分鐘 (f) 曝曬後通透性變化 

圖 7. 美甲燈光與太陽光對豬皮葉綠體通透性的影響 (自行拍攝) 

 

四、防護效果測試 

(一) 先以試劑確定葉綠體無法通透實驗豬皮表面[圖 8(a)]。 

(二) 實驗組豬皮塗抹不同抹劑，對照組塗抹清水[圖 8(c)]。 

(三) 照燈後，用卸妝水清洗後檢測，比較各種防曬抹劑的防護效果[圖 8(f)-(h)]。 

(四) 利用上述相同步驟，檢測並比較各種防曬抹劑對太陽光影響的防護效果。 

  

  

 

(a) 確認無通透性 (b) 清水洗淨 (c) 矽膠刷塗上抹劑 (d) 照燈(美甲組) 

  

 

 

(e) 曬太陽(陽光組) (f) 卸妝油清洗 (g) 清水再洗淨 (h) 檢測通透性 

圖 8. 各種抹劑的防護效果 (自行拍攝) 
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五、受測者測試結果 

   雖然我們研發的檢測方法，除了希望應用在紫外光對豬皮通透性影響的檢測，但我們更好

奇，美甲燈光造成人體皮膚受損的情形，需要多久時間復原，能提供美甲者相關的安全建議。

因此，我們徵求身邊定期進行美甲的成人同意，在專家指導下，進行實際測試。其日常活動

以教授室內課程或室內行政工作為主，避免工作形態差異成為影響實驗的變因。探討太陽紫

外光影響的部分，我們邀請學校球隊教練擔任受測者。我們也徵得身旁長輩同意，檢測長期

曝曬陽光產生的曬斑部位皮膚通透性有什麼不同。實驗流程如下: 

(一) 向學校申請人體實驗，請專家進行安全審查(審查資料如實驗日誌)。審查通過後，

再找尋身邊能配合定期檢測的成年師長與親人擔任受測者。 

(二) 詳細告知受測者實驗目的、流程與可能的風險，並請受測者簽署同意書[圖 9(a)]。 

(三) 受測者進行美甲前，先檢測確認葉綠體無法通透手指與手背皮膚[圖 9(b)]。 

(四) 受測者都進行單純上兩層甲膠，並接受 UV 燈美甲行程。 

(五) 進行美甲前一天開始，每日上午都進行皮膚對葉綠體通透性檢測[圖 9(c)-(d)]。 

(六) 先訪談球隊教練，了解他們每日平均日曬時間[圖 10(a)]。 

(七) 比較手背部曬斑部位與周圍部位皮膚對葉綠體通透性的差異[圖 10(c)-(d)]。 

    

(a) 簽署同意書 (b) 美甲前測試 (c) 後測試 (手背) (d) 後測試 (手指) 

圖 9. 美甲者不同部位皮膚通透性檢測 (自行拍攝) 

    

(a) 訪談 (b) 教練手背檢測 (c) 教練上臂檢測 (d) 長輩曬斑檢測 

圖 10. 球隊教練不同部位皮膚通透性檢測 (自行拍攝) 
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肆、實驗結果 

一、建立試劑製作標準化流程 

        為了建立適當的葉綠體試劑製作流程，我們以番薯葉為材料，找尋最適合的果汁機 

榨汁行程，以及最適當得過濾分離雜質程序，研究結果如下: 

(一) 製作蔬果汁的資料指出，每分鐘 8000 轉是完整破壞細胞壁的果汁機基本轉速。因

此，我們先以每分鐘 8000 轉，轉動 1 分鐘榨汁後，以濾網過濾上面的澄清液。 

利用手沖咖啡濾紙過濾，會造成濾紙嚴重堵塞，因此改用 100 目篩網。過濾後，雖

然汁液呈現墨綠色，在顯微鏡下看到的完整葉綠體卻不多數量相當少[圖 11(a)]。 

我們認為是果汁機轉速過快，破壞了葉綠體的結構。應該以低轉速的果汁機榨汁。 

(二) 我們改用低轉速果汁機，以每分鐘 3000 轉，轉動 1 分鐘榨汁，得到的澄清液雜質

又會堵塞 100 目篩網，使篩網難以清洗實驗。改用 20 目粗孔隙濾網後雜質仍然很

多，用 60 目的濾網進行第二次過濾後，菜汁仍然有些許黏性。最後，利用 100 目

篩網過濾後，顯微鏡下仍看到葉綠體與纖維互相糾纏成塊狀[圖 11(b)]。這次雖然又

失敗了，但卻讓我們發現網孔由粗到細的分段過濾，可以減少濾網堵塞。 

我們認為分段榨汁能讓懸浮菜汁中的物質沉澱後再榨汁，並分段過濾。 

(三) 轉速維持每分鐘 3000 轉，但改採分三段榨汁，每段轉動 20 秒，中間停留 10 秒，

等待塊狀物沉澱後再啟動下次的榨汁行程。上方澄清液先以 20 目濾網濾除粗纖

維，再以 60 目濾網濾除細纖維，經過 100 目濾網過濾懸浮雜質後，得到的澄清液

在顯微鏡下可以看到單純的葉綠體顆粒[圖 11(c)]。訂為試劑製作標準製作流程。 

圖 11. 不同製作過程試劑中葉綠體含量 (自行拍攝)  

   

(a) 8000 轉，1 分鐘 (b) 3000 轉，1 分鐘 (c) 3000 轉，三段各 20 秒 

0.1 mm 0.1 mm 0.1 mm 



11 
 

(四) 為了避免番薯葉用盡，我們嘗試找尋教材園內其他蔬菜進行萃取。經過討論，我們

認為適合榨汁的葉菜須具備以下條件: 

⚫ 葉綠素含量多 → 淘汰萵苣。 

⚫ 葉片質地柔軟 → 淘汰清江菜。 

⚫ 菜蟲少產季長 → 淘汰小白菜。 

篩選後選定番薯葉  (產季 5~11 月)、空心菜 (產季 3~11 月)，以及莧菜 (全年皆產)

三種蔬菜。在倍率 100 倍下觀察 0.1 毫升試劑葉綠體含量。發現番薯葉菜汁的葉綠

體含量最高[圖 12(a)]，其次為空心菜[圖 12(b)]，莧菜明顯較少[圖 12(c)]。 

圖 12. 放大 100 倍下三種蔬菜萃取試劑葉綠體含量 (自行拍攝) 

 

(五) 我們找尋免費的物體計數應用程式，計算葉綠體量。但精準度都很低[圖 13]。 

圖 13. 物體計數應用程式計算葉綠體數量 (自行截圖) 

   

(a) 番薯葉 (b) 空心菜 (c) 莧菜 

   

(a) Cell counter (b) Object counter-coin (c) Object counter-insect 

0.1 mm 0.1 mm 0.1 mm 
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(六) 利用 IimageJ 進行測量，將照片轉換為黑白格式後，調整對比度後進行葉綠素的計

算﹐確實能精確的自動計算畫面中的葉綠體含量[圖 14)]。計算結果發現，番薯葉

汁的葉綠體含量約為空心菜汁的 1.3 倍，約為莧菜的 2.6 倍[圖 15)]。因此，未來我

們優先選用番薯葉萃取液進行實驗。非番薯葉產季時，則以空心菜替代。若兩種蔬

菜皆無法取得時，再選用莧菜製作試劑。 

 

  

(a) 開啟照片 (b) 轉換 8 bits 格式 

  

(c) 調整 threshold 值 (d) 計算葉綠素數量 

圖 14. ImageJ 計算應用程式計算葉綠體數量 (自行截圖) 

 

File→Open Image→Type 

Image→Adjust→threshold Analyze→Analyze particals 

螢光點數量 
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圖 15. 三種蔬菜製成的試劑中葉綠體含量 (自行繪製) 

 

 

二、建立檢測標準化步驟 

(一) 為確保安全，實驗開始前我們利用紫外光強度檢測卡檢測皮膚檢測儀與美甲燈周圍

的紫外光強度。檢測結果發現，檢測儀探頭與美甲燈產生的紫外光強度都達到較強

等級，接近於晴天正午時空曠處的紫外光強度[圖 16(a)(b)]。遠離美甲燈 10 公分，紫

外光的強度就降為微弱等級[圖 16 (c)]，皮膚檢測儀旁並沒有紫外光反應[圖 16(d)]。

這種強度的紫外光，能被市售標明具有抗紫外光功能的手套完全阻隔[圖 16(e)(f)]。 

透過以上的測試，未來進行美甲燈實驗操作時必須包含以下三個安全原則: 

1. 配戴抗紫外光手套。 

2. 美甲燈照射時，須遠離 30 公分以上 

3. 每日進行美甲燈照操作時間不超過 10 分鐘。 
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圖 16. 實驗環境紫外光強度檢測 (自行拍攝) 

 

(二) 由於試劑塗抹過少或停留時間過短，葉綠體滲入豬皮內的效果不明顯，但塗抹過多

或停留過久，又會使葉綠體殘留在皮表難以洗除而影響螢光點判斷。為了找出最適

合的塗抹劑量與試劑停留時間。我們使用照射美甲燈光 240 秒後的豬皮，在表面塗

滿試劑，分為六組，分別是塗抹 0、1、2、3、4、5 分鐘後清洗，再以皮膚檢測儀觀

察。觀察發現試劑停留在表皮 2 分鐘後清洗，檢測儀下豬皮開始有些許螢光產生[圖

17 (c)]。等待 4 分鐘後，由於水分蒸發，葉綠體容易黏附在豬皮表面，難以洗除 [圖

17 (e)(f)]。黏附殘留在表面的葉綠體會形成片狀的光暈，可能覆蓋皮膚內葉綠體產生

的螢光點，影響計算的結果。 

塗抹試劑後，等待 3 分鐘清洗表面，是試劑停留表面最理想的時間。 

 

 

 

 

  

(a)美甲燈紫外光強度 (b)檢測儀紫外光強度 (c) 10 公分處降至微弱等級 

 

 

 

 

 

 

(d) 檢測儀旁無紫外光 (e) 檢測抗 UV 手套效果 (f) 抗 UV 手套阻隔效果佳 

美
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圖 17. 照射美甲燈後豬皮試劑塗抹時間測試 (自行拍攝) 

 

(三) 分別在照射美甲燈光 240 秒後的豬皮上塗抹 0.2、0.4、0.6、毫升的試劑 (0.8 毫升試

劑過多，會流出豬皮外)，對照組則塗抹相同體積的清水。等待 3 分鐘後以清水洗除

表面的菜汁，在檢測劑鏡頭下進行檢測，決定未來葉綠體試劑的使用量。檢測結果

發現，塗抹 0.4 毫升以上的試劑量檢測儀下才能看到光點[圖 18 (b)]，但 0.6 毫升以

上，又會看到皮膚表面的細紋有未洗淨的殘留葉綠素螢光點[圖 18 (d)]。我們再增加

塗抹 0.5 毫升的實驗組[圖 18 (c)]，3 分鐘洗淨後在檢測鏡頭下觀看沒有細紋殘留的問

題，螢光數量比 0.4 毫升更多。因此，未來實驗決定以 0.5 毫升的劑量進行檢測。 

圖 18. 照射美甲燈後豬皮試劑塗抹劑量測試 (自行拍攝) 

   

(a) 0 分鐘 (b) 1 分鐘 (c) 2 分鐘 (出現螢光點) 

   

(d) 3 分鐘 

(螢光點清楚可計數) 

(e) 4 分鐘 

(黃色區域為表面殘留) 

(f) 5 分鐘 

(黃色區域為表面殘留) 

    

(a) 0.2 毫升 (b) 0.4 毫升 (c) 0.5 毫升 

(螢光點可計數) 

(d) 0.6 毫升 

(表面殘留明顯) 
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圖 19. 試劑劑量與葉綠體通透量關係圖 (自行繪製) 

 

圖 20. 試劑最佳使用劑量與停留時間 (自行繪製) 

 

三、美甲燈光對皮膚表面結構的影響 

有些美甲業者目前已採用由紫外線與 LED 光

線組成，紫外光強度較低的混合型美甲燈(混

和燈)。比較兩種燈型的紫外光強度發現，在

紫外線美甲燈(UV 燈)照射下，感應卡已顯示

高於 800 uW/cm2的較強等級了。而混合燈紫 

 外光強度較低，但也有 500 uW/cm2。[圖 21 ]  圖 21. 美甲燈光紫外光強度 (自行拍攝) 
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(一) 我們仿照美甲行程照燈，分別將豬皮放置於不同美甲燈下照射燈光，並在照射後塗抹葉

綠體試劑進行皮膚滲透性的檢測。兩種美甲燈照射下 60 秒內，都沒有發現葉綠體滲入的

情況，顯示豬皮表面結構完整[圖 22 (a)]。但照射 UV 燈的在照射 90 秒後，開始發現有葉

綠體滲入豬皮下的情形[圖 22 (b)]，隨著照射的時間增加，滲入皮下組織的量也會快速的

增加。 

照射混合燈的組別於照射 90 秒內，仍然沒有看到葉綠體滲入皮下的情形[圖 23 (b)]，但在

照射 120 秒後開始有葉綠體滲入的情形[圖 23 (c)]，到 240 秒後，滲入的葉綠體量更多[圖

23 (d)]。除了 UV 燈照射對豬表皮結構的破壞較快，造成的孔隙也較大較廣泛。經歷完整

的美甲模擬流程後，照射 UV 燈組的豬皮，葉綠體滲入量約為照射混合燈滲入量的 2.3

倍。 

 

    

(a) 60 秒 (b) 90 秒 (c) 120 秒 (d) 240 秒 

圖 22. UV 美甲燈照射後螢光反應 (自行拍攝) 

 

 

    

(a) 60 秒 (b) 90 秒 (c) 120 秒 (d) 240 秒 

圖 23. 混合燈照射後螢光反應 (自行拍攝) 
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圖 24. UV 美甲燈照射時間與螢光點數量的關係 (自行繪製) 

 

 

 

圖 25. 混合型美甲燈照射時間與螢光點數量的關係 (自行繪製) 
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四、不同防護方式的效果比較 

    為了避免美甲照燈傷害，試著以簡單的防曬方法進行防護檢測。我們分別在豬皮表面塗

抹清水(對照組)、凡士林、SPF30 與 SPF50 四種防曬抹劑[圖 26 (a)-(d)]，經過 UV 美甲燈 240

秒曝曬後，觀察四組皮膚對葉綠體通透性的差異。我們發現清水組別滲入皮膚的葉綠素螢光

點相當密集，顯示照射後豬皮表面結構受損最嚴重[圖 26 (e)]。塗抹凡士林後螢光點明顯較

少，表示凡士林的塗抹具有一定的保護效果[圖 26 (f)]，而兩種防曬乳的保護效果都相當明

顯，其中塗抹 SPF50 高防曬係數防曬乳保護效果最佳，只看到 7 顆螢光反應亮點[圖 26 (h)]。 

    

(a) 清水 (b) 凡士林 (c) SPF30 防曬乳 (d) SPF50 防曬乳 

    

(e) 清水 (f) 凡士林 (g) SPF30 防曬乳 (h) SPF50 防曬乳 

圖 26. 防曬抹劑對皮膚的保護效果 (自行拍攝) 

(a)-(d)塗抹防曬抹劑的皮膚表面放大圖。(e)-(h)滲入皮膚內的葉綠體螢光點。 

 

圖 27. 防曬抹劑對皮膚的保護效果 (自行繪製) 
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五、人體皮膚檢測 

(一) 凝膠美甲彩繪期間檢測 

在實驗安全維護流程確認後，開始進行定期美甲成年受測者測試。我們請測試者同

樣都選擇兩層美甲膠的美甲程序，並進行 UV 燈的照射。進行美甲前一天，確認葉

綠體無法滲入手指與手背皮膚下。我們請一位較熟識的親人左右手分別進行 UV 燈

與混合燈的美甲行程，比較兩種美甲燈對皮膚通透性的影響。 

結果發現，接受 UV 美甲燈照射的右手，完成上色膠的流程後，手指皮膚已經對葉

綠體具有通透性，而完成封膠行程後，滲入量更為明顯[圖 28 (a)-(d)]。 

接受混合燈美甲燈照射的左手，完成色膠固色流程後，都還沒有對葉綠體具有通透

性。然而，在完成封膠的行程後，檢測也發現葉綠體能滲入皮膚。不過無論對葉綠

體產生通透的時間，以及滲入皮膚內的葉綠體數量都不像接受 UV 燈照射後那麼明

顯[圖 29 (a)-(d)]。 

    

(a) 第一層色膠 (b) 第二層色膠 (c) 加固膠 (d) 封膠 

圖 28. UV 美甲療行程後皮膚通透性的變化 (自行拍攝) 

 

    

(a) 第一層色膠 (b) 第二層色膠 (c) 加固膠 (d) 封膠 

圖 29.混合燈美甲行程後皮膚通透性的變化 (自行拍攝) 
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圖 30. UV 燈美甲行程間滲入皮膚的葉綠體數量 (自行繪製) 

 

 

 

圖 31. 混合燈美甲行程間滲入皮膚的葉綠體數量 (自行繪製) 
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(二) 美甲後追蹤檢測 

每日檢測四位受測者皮膚通透性，追蹤美甲後皮膚復原情形。在接受美甲燈照射

後，檢測都發現手指檢測都有螢光點產生，表示手指部位表皮構造發生改變。美甲

後，隨時間光點逐漸減少，第六天後所有受測者都不再檢驗出螢光點[圖 32, 33]。 

    

(a) 第 0 天 (b) 第 1 天 (c) 第 2 天 (d) 第 3 天 

    

(e) 第 4 天 (f) 第 5 天 (g) 第 6 天(無螢光) (h) 第 7 天(無螢光) 

圖 32. 追蹤美甲受測者皮膚通透性復原情形 (復原時間最長者，自行拍攝) 

 

   

(a) 第 1 天 (b) 第 2 天 (c) 第 3 天(無螢光) (d) 第 4 天(無螢光) 

圖 33. 追蹤美甲受測者皮膚通透性復原情形 (復原時間最短者，自行拍攝) 

 

圖 34. 美甲後受測者皮膚通透性復原情形 (自行繪製) 
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(三) 球隊教練不同部位皮膚的通透性測試 

我們分別檢測球隊教練手背皮膚與有衣服遮蔽的上臂皮膚。我們發現手背的皮膚都

較上臂皮膚通透性高，推測是手背皮膚沒有衣物遮蔽，較容易接受太陽紫外光照射

而造成結構受損[圖 35]。 

 

 

  

 

(a) 左手手背 (b) 右手手背 (c) 左手上臂 (d) 右手上臂 

 

 

  

(e) 左手背螢光 (f) 右手背螢光 (g) 左上臂螢光 (h) 右手背螢光 

圖 35. 球隊教練不同部位皮膚的通透性檢測結果 (自行拍攝) 

 

 

圖 36. 球隊教練不同部位皮膚葉綠體滲入量 (自行繪製) 
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(四) 曬斑部位皮膚通透性的觀察 

當長期曝曬陽光後，除了皮膚變黑，有時表面會出現俗稱曬斑的棕褐色斑點。有些

曬斑是無法復原的。我們好奇曬斑部位的皮膚通透性是否有變化。徵詢長輩同意

後，我們分別檢測手背上三個不同大小的曬斑。結果發現，在各個曬斑部位，皮膚

對葉綠體的通透性都相當高，而且像圖 37(a)(b)所標示的黃色虛線，曬斑部位與周圍

的皮膚出現明顯的界線。顯示在長期曝曬陽光後這些部位的皮膚結構已經形成無法

復原的損傷。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

圖 37. 曬斑部位皮膚的通透性檢測結果 (自行拍攝) 
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伍、討論 

一、 長時間曝曬在紫外光下，會加速皮膚膠原蛋白的分解，皮膚結構會變得鬆弛、毛孔擴

大，使得外來物質穿透皮表進入皮膚內部的機會增加。這樣的變化雖然不明顯，但失去

阻擋外來病菌與毒素的第一道屏障，更會增加皮膚感染、發炎的機率。因此，如果能即

時察覺這種細微的變化，更能及時進行適當的防護或休息。 

二、 許多皮膚檢測器配備伍氏燈，造成皮膚感染的微生物在毛孔累積的卟啉代謝物，可以利

用伍氏燈的紫外光激發會產生波長 600 奈米的螢光。這個設備常用來檢測皮膚感染的部

位，並進行治療。然而，如果能在皮膚感染前，觀察到通透性的改變，防護工作就能更

早一步開始。 

三、 市面上聲稱可以檢測皮膚通透性的檢測儀，是利用測量水分從皮膚表面流失的速率間接

地評估通透性。此方法常受環境的濕度、測試者體溫等因素干擾而產生誤差。我們彙整

網路上收集到的其他檢測方法與費用，發現需要相當高的成本與專業儀器。 

檢測方法 費用 說明 

水分流失測試 500~1500 元 評估經皮膚流失的水分速度，較不精準。 

導電度測試法 500~1000 元 由導電性評估皮膚完整性，需專業儀器。 

螢光染劑 2000~10000 元 觀察染劑滲透的能力，只用在臨床試驗 

弗朗茲擴散池 5000~20000 元 需特殊皮膚樣本，常用於藥品的研究。 

表 2. 各種皮膚通透性檢測方法 (自行整理製作) 

四、 葉綠體中的葉綠素分子由一個中心鎂原子組成，周圍環繞著一個稱為卟啉環的物質，這

種物質與肌膚表面微生物分泌的卟啉類代謝物結構相似，因此在受到伍氏燈 345 奈米的

紫外光照射時，會產生紅色螢光。 

五、 皮膚角質層毛孔的孔徑約為 20~50 微米，植物葉綠體的寬度只有約 2~5 微米，長度約

5~10 微米，在皮膚功能完整時，葉綠體不太容易穿透角質層。但是當皮膚表面結構受損

時，擴大的孔隙就能讓葉綠體輕易的滲入皮膚中，這項特點也成為我們開發皮膚通透性

檢測法的關鍵。 

六、 葉綠體主要存在於葉片上表皮內的柵狀組織細胞內。實驗室中葉綠體可以透過高速離心

進行分離萃取。缺乏專業設備下，我們用多次過濾的方式，讓葉綠體試劑成分更單純。 
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七、 新鮮的番薯葉柄常會分泌白色黏液，當中含有紫茉莉苷的物質，這個物質會造成番薯葉

汁黏稠影響過濾速度。測試發現，若將番薯葉放在冰箱冷藏六小時以上，黏液會逐漸乾

涸，榨汁後較容易濾除纖維，製作葉綠體試劑。 

八、 自然課本曾提到，輻射線的危害程度，取決於暴露的距離與時間。檢測結果也發現，只

要保持 10 公分以上的距離，美甲燈的紫外光影響就相當小，不需過度憂慮。但美甲

者，由於短距離照射紫外光，皮膚傷害就相當明顯。而美甲彩繪的工作者，由於長期可

能處在含有高能量的紫外光環境下，更應注意可能造成的工作傷害。 

九、 在表皮塗抹凡士林能使光線反射比率增加，並且保持皮膚表面的含水量，減緩表皮組織

受損情形，但若要表皮組織結構經過完整的 UV 美甲燈曝曬仍保持完整，還是要使用

SPF 50 高防曬係數的防曬乳進行防護。 

十、 利用我們研發的檢測方法，測試受試者做完凝膠美甲後手背皮膚通透性改變情形，發現

最慢在第六天就完全檢測不到光點，也就是皮膚組織完全復原。顯示皮膚組織的修護能

力很強，美甲燈帶來的傷害，在一周內可以復原。一般定期進行美甲彩繪者大約會等

3~4 週後，等新指甲慢慢長出來再進行下一次，這樣的間隔能給予表皮組織充分的修護

時間，應該不會像某些報導宣稱會造成恐怖的傷害。不過，如果經常對做好的凝膠指甲

感到不滿意，頻繁的用化學藥劑去除之後再重做，則可能造成皮膚加成性的傷害。 

十一、 研究發現太陽紫外光的傷害比美甲燈的傷害明顯，球隊教練長期曝曬於陽光下，即使進

行各種防曬措施，手指部位還是常常被忽略。因此，工作一定時間後轉移到室內環境，

隔絕太陽曝曬是相當必要的。測試間我們也意外發現，在前半週檢測，通透性較小。後

半週檢測通透性就明顯增加。這個趨勢是否與假日的休養，提供皮膚修復時間有關，值

得再進一步探討。 

十二、 在自然與環境單元討論的各種汙染事件中，我們發現一次性的汙染乍看之下十分嚴重，

但只要給大自然足夠的修護時間，依然有機會回復原本的環境。然而，持續存在的汙染

源，再棒的美景終將不復存在。紫外光對皮膚的傷害和環境汙染事件相當類似，只要讓

皮膚有足夠的休養復原時間，皮膚是可以回復原本健康狀態的。然而，長時間曝曬太陽

又沒有適度的防護與休息，最終會使皮膚皺縮或形成曬斑，成為無法回復的傷害。 
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陸、結論 

一、 植物葉綠素分子的卟啉環與皮膚表面微生物分泌的卟啉類代謝物結構相似，利用低成

本的皮膚檢測儀也能激發植物葉綠體產生螢光，用以偵測葉綠體數量與位置。 

二、 皮膚通透性增加是皮膚損傷的重要指標，卻需高價的專業儀器檢測。正常狀態下，動

物皮膚毛孔間隙小，對葉綠體不具通透性。當皮膚通透性增加時，葉綠體即能穿越間

隙而進入皮膚。搭配葉綠體螢光的激發，能透過葉綠體滲入量，評估皮膚通透性的變

化，開發一套低成本的檢驗方式。 

三、 照射 UV 美甲燈 2 分鐘後便能觀察到豬皮通透性增加，且須高防曬係數防曬乳才具有完

全的阻隔效果。顯示短時間、近距離的紫外光照射，對皮膚結構產生傷害相當明顯。 

四、 照射美甲燈會顯著改變皮膚通透性，但皮膚細胞修護能力強，在一周內能復原通透性

改變的皮膚。美甲者勿在短時間內重作美甲，提供皮膚足夠的修護時間。 

五、 皮膚是防禦外來物質入侵人體的第一道防線，雖然能在短時間內修復輕微損傷，但若

持續受到長期傷害，將造成無法復原的不可逆傷害。球隊教練或美甲師等有經常暴露

於紫外光環境的人，更應適時進行防護。 
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【評語】082913  

1. 本研究利用蕃薯葉汁液的葉綠素能滲入受損皮膚的特性，並

以伍氏燈的紫外光激發葉綠素螢光，來評估皮膚損傷程度。

低成本與操作簡便性成為開發皮膚通透性檢測法的關鍵。 

2. 實驗利用果汁機均質後取得的蕃薯葉汁液，於顯微鏡下觀察

的可能非葉綠體胞器，且製成試劑時如何穩定濃度且維持活

性，是未來可以深入探究的因素。 
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綠葉薯光
—利用番薯葉綠體偵測皮膚受損程度

圖片來源：皆為本研究作者自行繪製及拍攝



壹、研究動機
進行凝膠美甲後，手背會有類似曬傷的感覺。原本想研發天然的葉綠素防曬品，改善美甲後的不適感。不過
意外發現，表面塗抹綠色菜汁的豬皮，照射紫外光美甲燈後，菜汁的葉綠體能滲入表皮，利用皮膚檢測儀(伍
氏燈)觀察，在紫外光下呈現紅色光點。我們推測紫外光會造成皮膚孔隙變大，增加葉綠體的滲透。因此，我
們想透過偵測葉綠體滲入皮膚數量的變化，研發一套安全低成本的檢測方法，追蹤皮膚受損程度及復原情形。

肆、研究設備及器材

貳、研究目的
一、探討紫外光對皮膚造成的影響與傷害。

二、了解各種檢測皮膚受損方法的原理，並研發新的檢測方法。

三、檢測美甲燈光對皮膚的傷害。

四、探討各種防曬品對紫外光傷害的防護效果。

五、研究紫外光對人體皮膚的傷害，並評估其復原能力。

研究概念圖

參、文獻探討與形成假設

一、建立葉綠體試劑製作的標準化流程

二、建立試劑檢測的標準化流程

(一) 果汁機榨取蔬菜汁。

(二) 濾網過濾後檢驗試劑葉綠體含量。

(三) 檢測儀檢測葉綠體螢光。

(一) 照射美甲燈後的豬皮，以面膜刷塗抹試劑。

(二) 分組測試等待0~5分鐘後清洗，找出最佳停留時間。

(三) 分別測試0.2~0.8毫升劑量，找出最佳劑量。

(四) 以ImageJ計算葉綠體螢光點，分析滲入量。

三、探討美甲燈光與陽光對豬皮葉綠體通透性的影響

一、實驗材料 :

果汁機、各類篩網、相關防曬品、面膜刷、

兩類型美甲燈 (UV光源、混合光源) 

二、生物材料 :

蔬菜葉片、帶毛豬耳及後頸部豬皮

三、檢測儀器 :

伍氏燈、紫外光檢測卡、顯微鏡、

計數軟體 (Cell counter、Object counter、ImageJ) 

伍、研究過程和方法

偵測皮膚內葉綠體螢光，可分析皮膚受損程度

(一) 參考美甲流程照射美甲燈後檢測。

(二) 烈日下曝曬20分鐘後進行檢測。
(三) 分析螢光點數量，評估豬皮對葉綠體通透性變化。

四、防護效果測試

(一) 確定葉綠體無法通透後塗抹各種防曬品。
(二) 照燈後以卸妝油清洗檢測各組通透性差異。
(三) 以相同步驟檢測各種防曬品的防曬效果。

五、美甲受測者測試

(一) 成年美甲受測者簽署同意書 (書面資料如日誌) 。
(二) 各美甲照燈步驟後檢測手部皮膚通透性變化。
(三) 美甲後每日追蹤受測者皮膚通透性變化。

皮膚檢測儀(伍氏燈)

(一) 受測教練簽署同意書 (書面資料如日誌) 。
(二) 訪談球隊教練工作內容與防護方式。
(三) 比較手背、上臂部位皮膚通透性的差異。
(四) 訪談並記錄長輩曬斑形成原因與時間。
(五) 比較各個曬斑部位與周圍皮膚通透性的差異。

六、球隊教練與長輩曬斑部位測試

正常皮膚 受損皮膚



一、建立試劑製作標準化流程

陸、實驗結果

每分鐘8000轉
1分鐘 100目濾網過濾

1.葉綠體過少
2.降低轉速，減少葉綠體破壞
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二、選擇適當植物並建立標準化時間與劑量

三、利用豬皮比較不同美甲燈光對皮膚通透性影響

五、各種防曬品對紫外光的防護效果比較

每分鐘3000轉
1分鐘

20目→60目
濾網過濾

1.纖維糾纏成塊，難以過濾
2.分段榨汁，纖維沉澱再榨汁
3.分段過濾，避免濾網賭塞

Ⅹ

每分鐘3000轉
3次，每次20秒

20目→60目→100目
分段過濾

建立試劑製作標準化流程

(一)參考綠拿鐵製作流程

(二)降低轉速試驗

(三)三階段榨汁，三階段過濾試驗 √

(一)番薯葉汁葉綠體最多，為空心菜1.3倍，莧菜2.6倍 (二)塗抹試劑3分鐘後清洗，是試劑最佳停留時間

(三)塗抹0.5毫升為試劑最佳劑量

(一) UV美甲燈完成上色膠流程後，已經有葉綠體滲入

(一)照射UV燈的在照射90秒後有葉綠體滲入 (二)照射混合燈的在照射120秒後有葉綠體滲入

四、凝膠美甲對人體皮膚的影響

(二)混合美甲燈完成封膠流程後，已經有葉綠體滲入

有效試劑的葉綠體含量須達600顆/0.1毫升

1. UV燈影響較為顯著

2.人體皮膚防護力較佳

• 隨防曬品防曬係數增加，防護效果越明顯

UV美甲燈 混合美甲燈



柒、結論與未來展望

一、植物葉綠體的長度約5微米，寬度約2微米。通常無法穿透毛髮與毛囊的間隙。但皮膚受損時，毛孔間

隙會擴大，葉綠體能輕易的滲入皮膚內，利用伍氏燈激發葉綠體螢光，偵測滲入皮膚內葉綠體數量，
能作為評估皮膚表面結構完整的的指標。

二、實驗室常需透過多種的有機溶劑與高速離心機分離純化得到完整的葉綠體，設備昂貴步驟複雜繁瑣。

本研究發現利用果汁機分段的以每分鐘3000轉破壞植物細胞壁構造後，分段過濾雜質，最後以孔徑約

149微米的100目濾網過濾後，也能得到高含量葉綠體的最佳檢測試劑。

三、動物皮膚照射美甲燈後，外觀雖然沒有明顯變化，但通透性已有明顯增加的現象，顯示短時間、近距

離紫外光照射，就能對皮膚結構產生影響。需要高防曬係數防曬乳才能有效阻隔紫外光。

四、評估凝膠美甲傷害的嚴重性，除美甲燈種類、接受照光的時間外，應考量進行美甲的間隔時間。研究
發現最遲能在六天內葉綠體已無法滲透進毛孔，顯示皮膚的損傷已修護。多數人每月進行一次美甲，
，如此的頻率，手背的皮膚應能充分修護。進行美甲帶來的紫外光傷害，應不如報導宣稱的嚴重。不
過，若短期內反覆施作美甲，皮膚沒有充足的修護時間，持續累積的傷害，最終可能造成無法復原的
損傷。

五、日曬造成的紫外光傷害比美甲燈嚴重。皮膚雖能自行修復輕微損傷，但若長期持續受到傷害，將造成

無法復原的損傷。手部的防曬，常被忽略，除了塗抹防曬品外，應避免長時間於烈日下曝曬。

六、本研究證實能利用葉綠體通透性評估皮膚表面損傷程度，期望未來能使用這種低敏感的檢驗法，應用
於醫學、藥品的檢測。

捌、參考資料
一、陳鈞彥等。2017年。Oh ！「葉」 ~利用手機光譜儀探討市售植物油在可見光雷射照射下發光之行為。

第57屆中小學科學展覽會作品說明書。

二、顏重河摘譯/楊啟裕審。2007。豬耳朵皮膚替代人類皮膚的實驗模式。農業知識庫。

三、皮膚診斷光學儀器簡介-伍氏燈及皮膚鏡。取自皮膚專家健康網：https://www.drskincare.tw/Qa/Detail.aspx?ID=95。

七、太陽紫外線對人體皮膚影響

(一)球隊教練手背皮膚長時間日曬通透性較高 (二)曬斑皮膚通透性高，與周圍皮膚形成明顯界線

1
2

3

六、美甲受測者皮膚通透性復原情形
(一)受測者1-第6天起不具通透性

(二)受測者2-第4天起不具通透性

(四) 追蹤四位受測者手背通透性變化情形

(三) 受測者3與受測者4手背皆於第5天起不具通透性

1. 各受測者皮膚通透性皆有明顯復原情形。

2. 受測者1第2~3天從事較長時間戶外活動，

推測戶外曝曬陽光是延緩皮膚復原主因。

防曬程度會影響不同部位皮膚的通透性。 曬斑生成顯示皮膚已造成無法復原的損傷。
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